
  About InsertImageSVG


  Version 0.2.1.2


  Introduction


  This plugin will wrap an image in SVG code and insert it in a new xhtml page so that the image is displayed correctly in your ebook reader. The image may be present in the /Images section of your eBook or the image can be imported from an external file using this plugin. The following image files are supported:


   



  bm


  bmp


  gif


  jpeg


  jpg


  png


  tiff


  tif'


   



  This version of the plugin has been tested with Sigil version 0.9.9 in Windows 7. It should run on other versions of Windows and on Linux and Mac operating systems that are able to run Sigil.


  Requirements


  The plugin will run in Sigil using the version of Python that is supplied with Sigil. If you want to run this plugin using an external version of Python then you will need to ensure that Python 3.4 is installed on your computer, together with Pillow  and Beautiful Soup.


   



  Warning


  Make sure that you have a backup of your ePub file before running this plugin.


  THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OF THIS SOFTWARE BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.


  Licence


  This plugin is placed in the public domain. It may be modified for any purpose on condition that any derivative works are also placed in the public domain with this condition and the above warning attached.


  Installation


  If you have a previous version of this plugin installed on your PC then it is recommended that you delete the old files associated with it by selecting Preferences from the Edit menu in Sigil and clicking Open preferences location. Open the folder plugins_prefs and delete the folder InsertImageSVG and all its contents. Also delete the folder InsertImageSVG and all its contents from the plugins folder.


  To install the plugin, open Sigil and select Manage plugins from the Plugins menu or press function key F5.


  Click Add plugins.


  Navigate to the location of the plugin zip file named InsertImageSVG and open it.


  Click OK.


  If you are using Sigil 0.9.9 then close Sigil before running the plugin for the first time. There is a bug in this version of Sigil that causes the plugin to loop if you try to run it as soon as it is installed.


Using the plugin

  Running the plugin


  From the Plugins menu in Sigil select Edit followed by InsertImageSVG.
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  The plugin will run automatically.


  When the main window for the plugin opens up you will see a list of all the image files that are in your eBook. The first image in the list will be highlighted and displayed.


  [image: Villages]


  Inserting an image from the ebook into an xhtml page


  If your ebook contains images in the Images section of the ebook then you can wrap one or more of these images in SVG code and insert each one in its own xhtml page so that the image is displayed correctly by following this procedure:


  1. Click on the name of the required image in the displayed list; the selected image will be displayed.


  2. Select the position of the xhtml section that will contain the image (wrapped in SVG code) as follows:


  	To insert an xhtml page containing the image so that it becomes the first page in your ebook select At the start from the drop down box beneath the label Select position - this can be useful for inserting the cover page.


  	To insert an xhtml page containing the image so that it becomes the last page in your ebook select At the end from the drop down box beneath the label Select position - this can be useful for inserting the back cover.



  	To insert an xhtml page after a particular xhtml section in your ebook select After: from the drop down box beneath the label Select position. Another drop down box will be shown. This lists all the xhtml sections in your ebook. Select the appropriate xhtml section from this box.



  	To insert an xhtml page before a particular xhtml section in your ebook select Before: from the drop down box beneath the label Select position. Another drop down box will be shown. This lists all the xhtml sections in your ebook. Select the appropriate xhtml section from this box.


  


  If you select either At the start or At the end from the first drop down box then the second drop down box will not be shown.


  3. Click the Insert button when you have made your selection to insert the image in an xhtml page in your ebook.


  If you decide that you do not want to insert an image then click the Close button or press the Escape key to close the plugin window.


  Inserting an image from an external file


  If you want to import an image from an external file and insert it in an xhtml page with SVG formatting, then use the following procedure:


  1. Click the button labelled Import external image. This will open a file dialog box.
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  2. Navigate to the required folder and double click on the name of the image to be imported. The selected image will be displayed in the plugin window. However, it will not be loaded into the ebook at this stage. The buttons marked Insert and Copy will change colour to remind you that you need to press one of these buttons to include the image in your ePub.


  [image: SVGImageDialog]


  3. Select the position of the xhtml page that is to contain the image as discussed in the previous section.


  4. Click the Insert button to add the image into your ebook and to insert it into an xhtml file.


  If you decide you do not want to insert an image then click the Close button or press the Escape key to close the plugin window.


  Pasting an an image with SVG tags into an ePub


  You use this plugin to paste an image with SVG tags into a particular part of your ePub. If the image is already in your ePub, run the plugin, click the name of the required image in the displayed list, and click the Copy button. This will copy the image and insert SVG tags. If you are using a version of Sigil below 1.0.0 switch to Code View. Place the cursor in your document where the image is to be inserted, and click CTRL-V. The image will be pasted into your ePub.


  If the image is not already in your ePub, run the plugin and click the Import external image button to open a file dialog box. Navigate to the required file and double click on the name of the image to be imported. The selected image will be displayed in the plugin window and the buttons marked Insert and Copy will change colour to remind you that you need to press one of these buttons to insert the image in your ePub. Do not press the insert button otherwise the image will be inserted into a new page. Press the Copy button to load the image into your eBook and to copy the image to the clipboard with SVG tags. If you are using a version of Sigil below 1.0.0 switch to Code View. Place the cursor in your document where the image is to be inserted, and click CTRL-V. The image will be pasted into your ePub.


  Undoing changes


  You cannot undo changes made to your ebook using the plugin. If you have inserted an xhtml page that is not required or you have imported an image that you do not require then this must be deleted manually from your ebook.


  Setting the default folder for external images


  The default folder for importing external images is C:\ However, this may be changed by clicking the button marked Default folder. This opens a directory browser. Navigate to the folder that you want to set as the default folder and click Select folder. Next time you press the button to import an external file, images in the folder that is set as your default folder will be displayed. The plugin remembers your default folder next time you open the plugin.


  Updates


  When you run the plugin it will check the web to find out whether an update is available. A message will be displayed in the Sigil Plugin runner window to let you know whether the installed plugin is current or whether an update is available (You need to click the Details button to see this information).


  If an update is available a window will open with three buttons:
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  1. Go to webpage


  This will take you to the page at mobile read that provides a link for the updated plugin (and manual if appropriate). You will need to download the update to your computer and then install the plugin manually.


  2. Set time before checking for updates


  This opens another window labelled Set update timing that allows 

 (i) the time between checks for updates to be set (in hours) and

 (ii) reminders that an update is available to be set (in minutes).

The default values are 24 hours and 60 minutes respectively.
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Click the button labelled Close to save any changes that you make to these times.


  3. Remind me later


  This option closes the reminder window and will remind you about the update later, using the times set in the window Set update timing.


  4. Before installing updates


  Before installing an updated version of the plugin the older version must be uninstalled as follows:


  1. In Sigil, select Manage Plugins from the Plugins menu. This opens a window that shows a list of installed plugins.


  2. Click on the name of the plugin (FootnoteManipulator) to highlight it.


  3. Click Remove plugin


  4. Click OK.


  5. Install the updated plugin (see the section Installation above). Previous settings will be retained.


  Using the plugin with Sigil version 1.0.0.0


  This plugin is compatible with all versions of Sigil.


  Images are inserted in the Book Browser in the position that you select using this plugin as illustrated by the xhtml section SVG_Lake_01.xhtml below.
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  However, the xhtml page that contains the image may not be inserted in the required location in the underlying structure of your eBook for Sigil version 1.0.0.0 and above. You can move the xhtml page containing the image to a different location in the underlying structure of your eBook after running this plugin by right-clicking on the xhtml section that contains the image and selecting Move from the pop up menu.
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  You can then select the folder in the underlying ePub structure where you want to put this page from the drop down box that appears:
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  After selecting the required location click the OK button.


  Similarly, you may want to move any imported images to another location in the underlying structure of your eBook.


  What's new?

  Version 0.2.1.2

Bug fixed: The default directory could not be retrieved when Sigil closed. This fault has been rectified.

Version 0.2.1.1



	Checking for updates - you can set the time interval between reminders

	The copy button changes colour when an image has been selected for import

	Code has been improved for the copying process.






  Version 0.2.1.0


  This version enables an image to be copied to the clipboard so that it can be pasted into the ePub wrapped in SVG code.


  Version 0.2.0.0


  This version makes this plugin compatible with Sigil version 1.0.0.0


  Version 0.1.6.0


  This version lists the names of the images in alphanumerical order.


  Version 0.1.5.0


  This version has been adapted to work with ePub 3 files and continues to support ePub 2 files.
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